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1 Introduction 

1.1 Document Scope 
This document describes the installation, configuration and operation of the Vingtor-Stentofon 
Recorder Software version 2.0. 

The information in this document is aimed at System Administrators, System Installers and End 
Users.  

1.2 Publication Log  
Revision Date Author Status 
1.0 5.5.2015 HvD, HKL Published 
1.1 27.12.2016 HvD Use of playback timers 

Start recording through HTTP 
Appendix A7: Problem solving 

1.2 11.12.2017 HvD Removal of analytics 
Added description to restart the 
service automatically on failure 

1.3 15.1.2018 HvD Possibility to assign Playback 
rights to operators independent of 
‘Live monitoring’ rights 

1.4 19.2.2021 HvD Ordering and licensing information 
updated 

1.5 22.7.2021 HvD, HKL Prerequisites paragraph update, 
Zenitel logo replaces VS logo. 

1.6 3.1.2022 HvD Enterprise server removed 
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2 Vingtor-Stentofon Recorder 2.0 

2.1 General Description 
Vingtor-Stentofon Recorder 2.0 provides the following functionalities: 

• AlphaCom XE Call Recording 
o All terminal types: IP intercom, analog intercom, IP phones, analog phones 
o All call types: calls, group calls, conferences 

• Video Recording 

• Vingtor-Stentofon IP station audio stream recording 

• Scheduled Recording 

• Event Recording 

• Event Recording on audio streams with pre-event recording 

2.2 Server Specifications 
Depending on the size of the total system, the hardware requirements for the recorder server can 
vary widely. The table below uses the formula AvailableFrequency=NrOfCores * 
CoreClockSpeed to give some measure of processing power. 

Operating System Windows 7 or later, Windows Server 2008 or 
later 

Processing Power * The required processing power depends on 
the overall system configuration. For 
calculating the required number of processor 
cores and frequency, the following can be 
taken as a guideline: 

- Video – 150 MHz per stream 
- Audio – 75 MHz per stream 

Memory The minimum amount of available memory 
must be 4 GBytes 

Maximum number of AlphaCom recording 
modules 

10 

Maximum number of simultaneously recorded 
AlphaCom calls 

64 

Maximum number of simultaneous audio/video 
streams 

64 

*) Required minimum processing power is an indication only. Multiple clients each viewing different video 
streams requires more processing power than when all clients view the same streams. The table takes this 
into account to a certain degree only. 
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3 Installation 
The Vingtor-Stentofon Recorder 2.0 consists of 2 packages: the Recorder Server and the Recorder 
Client. Server and client can be installed on the same PC, but can also be installed on different 
PCs connected to a LAN. Both packages depend on the presence of 3rd party software.  

3.1 Prerequisites 

3.1.1 Server 
The server requires the software as detailed in the following sections to operate correctly.  

3.1.1.1 .NET 
• Download and install .NET 4.5.1 or later from the Microsoft website 

(http://www.microsoft.com/en-us/download/details.aspx?id=42642).  

Note that this link is correct at the time of writing but that updated versions may have a new link. 

3.1.1.2 SQLExpress 
Make certain that Microsoft SQL Server (2008R2 or newer) or Microsoft SQL Express (2008R2 or 
newer) is installed. 

3.1.1.3 VC++ 2010 SP1 redistributable 
Download and install the VC++ 2010 SP1 redistributable from the Microsoft website 
(http://www.microsoft.com/en-us/download/details.aspx?id=8328).  

3.1.1.4 VC++ 2012 Update 4 redistributable 
Visit http://www.microsoft.com/en-us/download/details.aspx?id=30679 

• Click Download 

• Select VSU_4\vcredist_x86.exe   

• Click Next 

3.1.1.5 SQL Server 2012 Feature Pack (optional) 
Elements from the feature pack only need to be installed when the SQL instance is not on the 
same PC as the recorder server. The feature pack must be installed on the PC on which the 
recorder server will be installed. Note that the SQL Server 2012 Feature Pack also covers SQL 
Server 2008 as described in section 3.1.1.2. 

• Visit http://www.microsoft.com/en-us/download/confirmation.aspx?id=29065  

• Click Install Instructions 

• Scroll down the page to the heading Microsoft® SQL Server® 2012 Native Client 

• Download and install the package X86 Package (sqlncli.msi) 

• Scroll down further to the heading Microsoft® SQL Server® 2012 Command Line 
Utilities 

http://www.microsoft.com/en-us/download/details.aspx?id=42642
http://www.microsoft.com/en-us/download/details.aspx?id=8328
http://www.microsoft.com/en-us/download/details.aspx?id=30679
http://www.microsoft.com/en-us/download/confirmation.aspx?id=29065
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• Download and install the package X86 Package(SqlCmdLnUtils.msi) 

3.1.1.6 Windows update 
After installation of the above: 

• Click the Start icon and select Windows Update 

3.1.2 Playback & Configuration Client 
The Playback Client needs the software as detailed in the following sections to operate properly. 
Most of the prerequisite software is available on the AlphaWiki download page. Windows Media 
Player and DirectX must be downloaded from the Microsoft website. 

3.1.2.1 .NET 
• Download and install .NET 4.5.1 or later from the Microsoft website 

(http://www.microsoft.com/en-us/download/details.aspx?id=42642).  

Note that this link is correct at the time of writing but that updated versions may have a new link. 

3.1.2.2 Windows Media Player 
Windows Media Player is normally part of the Windows operating system. In case Windows Media 
Player is not installed, go to the Microsoft website (www.microsoft.com) and search for Windows 
Media Player. You will be directed to the page where the Windows Media Player relevant to your 
operating system can be downloaded and installed. 

3.1.2.3 DirectX V9C or later 
DirectX is normally part of the Windows operating system. To find out which version is installed on 
your PC: 

• Click the Start icon and type dxdiag in the search box and start the application.  
• Click the System tab to check the version information.  

If the version is lower than DirectX V9C follow the instructions on the Microsoft web page. Go to 
www.microsoft.com and search for DirectX. 

3.1.2.4 ffdshow 
Visit http://sourceforge.net/projects/ffdshow-tryout/files/latest/download?source=files to download 
and install the latest files. 

3.1.2.5 Windows update 
After installation of the above: 

• Click the Start icon and select Windows Update. 

3.2 Server Installation 
The Server installation file VSRecorder2Setup.msi is available from the AlphaWiki download 
page.  

• Download the software and double-click the file to start the installation. 

Please read the EULA carefully and accept if you agree. The installation wizard suggests an 
installation directory, but it is possible to set a different directory. 

3.2.1 Server Configuration 
Towards the end of the installation process a configuration dialog-box will be displayed.  

http://www.microsoft.com/en-us/download/details.aspx?id=42642
http://www.microsoft.com/
http://www.microsoft.com/
http://sourceforge.net/projects/ffdshow-tryout/files/latest/download?source=files
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• The configuration can also be run after installation by selecting Configure Savvault after 
clicking Start > VINGTOR-STENTOFON > VINGTOR-STENTOFON Recorder. 

 

If no database instance is selected automatically: 

• Click Search to fill in the dropdown list with SQL servers that can be reached.  

• Then select the instance which is to be used by the recorder server.  

If no instance is listed, then please make certain that the service SQL Server Browser Startup 
Type is set to Automatic and that the service is running. 

 

• If you have already received a license file, navigate to that file and click the button Set 
License to open a file browse window. 

The Recorder service will operate with equipment connected to any of the server’s networks. 
However, some equipment does require that one network is named. This can be done by filling in 
the appropriate server IP address in the IP Address field. 

• Define a unique name for the recorder server.  
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Uniqueness of the name is very important when there are several Vingtor-Stentofon recorders in a 
system and the same playback client has to be used to contact them. 

Under the Storage Management tab it is possible to define where media files must be stored and 
how long logs and media files of recordings should be kept. When information under this tab is not 
filled in correctly an error message will appear when the Save button is clicked on any tab in the 
dialog-box. 

 

The Recording Repository path can be set to any directory on any machine which can be 
reached. Make certain that the directory does exist, as otherwise the recorder server will stop 
immediately with an error message after being started. To prevent typing errors and thus 
mismatches it is advisable to use the Browse button; within that dialog-box it is also possible to 
create a directory. 

Make certain that the Repository Trim Size is set to less than 90% of the disk space you want to 
use for recordings such that new recordings can be added before old recordings are deleted. Logs 
and media files can also be deleted when they are older than a certain number of days. 

Under the Ports tab it is possible to change the port numbers for some of the services. Normally 
this can be left with the default settings. Only when other software is already occupying a port, or 
specific firewall rules require another port to be used is there any need to alter any of these 
settings. 

The Misc tab provides some miscellaneous setting possibilities. SIPvault is not a system which 
will be used in this recorder setup, and the selected codec is therefore of no consequence. The 
other check boxes can be set as required. Note that by default the recorder will try to connect to 
defined media sources. This can be set to Stream-On-Demand. In the current Vingtor-Stentofon 
Recorder setup this is only relevant for video cameras. Setting to Stream-On-Demand uses less 
network bandwidth, as the recorder only connects when a camera is selected for viewing or 
recording. The drawback is that the video is unavailable for the time it takes to connect to the 
camera. 
RTP Playback Timer (introduced in version 2.1.3.11) gives the possibility to select specific timer 
options to be used during audio playback. With setting Auto-Default, the server selects the timer 
which it thinks is the most appropriate. Select Windows Multimedia Timer or Altenative Timer 
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manually if the playback sounds choppy. Choppy audio may also occur when the server and 
playback client computers have a significantly different date/time setting, it is therefore advisable to 
synchronize the time to an NTP-server. Especially systems where the server is running on a VM 
can be prone to timing issues. 

• When all settings have been done click the Save button 

• The service can now be started 

o Go to Computer Management and open the Services dialog-box 

o Select the service NVR2 Service and start the service 

As stated above, the configuration can also be done or changed at a later stage. The server 
service must be stopped before any configuration can be done. After that the service can be 
started again. 

There can be unforeseen reasons why the service stops. It is advisable to set service to 
automatically start again. 

• Go to Computer Management and open the Services dialog-box 

• Select the service NVR2 Service, right click and select Properties 

• Select the TAB Recovery 

• Set First failure, Second failure and Subsequent failures all to Restart the Service 

3.3 Playback & Configuration Client Installation 
The installation file VSRecorder2ClientSetup.msi is available from the AlphaWiki download page.  

• Download the software file and double-click the file to start the installation. 

Please read the EULA carefully and accept if you agree. The installation wizard suggests an 
installation directory, but it is possible to set a different directory. 

 

3.4 Licensing 

3.4.1 General 
The Vingtor-Stentofon Recorder 2.0 software is available for free from AlphaWiki, but without a 
license, the server service will stop immediately after it has been started. 

3.4.2 Licenses and Item Numbers 

Item number Description Comment 

1190110100 Vingtor-Stentofon Recorder - Base 
Module 

Basic software, includes a connection license for 1 Client 
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1190110110 Vingtor-Stentofon Recorder - 
Playback/Configuration Client 

License for additional clients – only a connected client consumes a 
license 

1190110120 Vingtor-Stentofon Recorder - 
AlphaCom Recording Module 

License for AlphaCom call recording; each connected AlphaCom requires 
its own license; 
Each license includes 2x 1190110138 

1190110121 Vingtor-Stentofon Recorder - 
AlphaCom Recording Module, 
AddOn 

As 1190110120, but excluding the stream licenses. 1190110120 must be 
present in the system before this license can be purchased  

1190110131 Vingtor-Stentofon Recorder - 
Stream Recording Module, 1 
stream 

License for 1 audio or video device – only in combination with 
1190110120 or 1190110138 

1190110138 Vingtor-Stentofon Recorder - 
Stream Recording Module, 8 
streams 

License for 8 audio or video devices 

1190110180 Vingtor-Stentofon Recorder - 
Secure Audio Export 

License to export an audio recording, including a stand-alone playback 
client 

3.4.3 Demo Licenses 
A free demo license is available on AlphaWiki. The demo license provides a full functional system: 

• A Playback and Configuration Client 

• Connection for 1 AlphaCom 

• 8 streams/devices for intercom call recording, camera connection and/or permanent audio 
streams 

• Secure audio export 

With the demo license the software runs for 5 hours. After this time, the software will delete all log 
and media files and the service will stop. It is possible to restart the service again manually. 

3.4.4 Obtaining a License 
The procedure to obtain and activate a license is as follows: 

• Download LicenseRequestUtility.exe from AlphaWiki to your PC 

• Double-click the downloaded file to run the utility and fill in the form shown below 
o Red fields are mandatory 

• Click Generate Request File 
• Save the resulting file - the default file name is related to the information entered in the form 

• Send the file together with the purchase order to cs@zenitel.com. 
The support information is obtained directly from your PC. If you feel uncomfortable providing this 
information, it is possible to delete it, but for future support it is highly recommended to supply this 
information.  
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You will normally receive a license file within 2 business days. 

The file has file extension .lic. Refer to section 3.2 for information on how to install the license. 

NOTE: Licenses can be replaced once in case of failure of the hardware of the computer on which 
the software is running up to a period of 3 years after initial purchase.  
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4 Configuration 
Configuration of the system is done via the Playback & Configuration Client. 

4.1 Connection to the Server 

 

On startup of the client, a login dialog-box will be displayed. When starting the client for the first 
time on a particular machine, cancel the dialog-box. 

To connect to the server: 

 Select File > Setup Server Connections from the top menu 

 Cick Add New in the new dialog-box  

 Enter the IP Address of the server machine and the Connection Port (default is 8080, see 
section 3.2) 

 The Default User is optional - this is used on client startup to enter the user name 
beforehand 

 Enter values for Auth User and Auth Password (necessary for the client to connect to the 
server) 

o Default user/password: admin/12345 
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 Click Authenticate 

 If the server can be reached, the Friendly Name will be filled in automatically 
o this is the name given to the server during the installation process (see section 3.2) 
o A new button Commit Changes will then be displayed: 

 Click Commit Changes to store the connection details 

The same client can connect to several servers, so it is possible to define multiple connections. 

4.2 Logging On  
To log on to the server: 

 

 Select File > Logon 
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 Select the Server to connect to 

 Enter the Username – default: admin 

 Enter the Password – default: 12345 

After logging in, the top menu will display new options: Actions, Setup, Reports, New Window. 

 

4.3 Setup Menu 
The Setup menu item is only available to users with the appropriate user rights. The default user 
admin with password 12345 does have these rights. 

• Click Setup on the top menu 

 

The various setup options are now accessible as icons on the top menu. 

• Click Add to create a new setup option 

• Click Edit to change an existing setup option 

• Click Delete to remove a setup option 

 

 

 



 
 
 

Recorder 2.0 
 

 

 
Vingtor-Stentofon Recorder 2.0 Manual  17 
 

4.3.1 Schedule Setup 

 

• Click the Schedule Setup icon on the top menu 

Schedule Setup allows an administrator to create, modify and delete schedules on the Recorder 
Service. These schedules are used to define server-based scheduled recording times and 
determine the validity of permission groups. Schedules can be added, edited or deleted. 

 

A schedule on the Recorder Service is defined by one or more schedule elements. Each schedule 
element comprises a single day of the week and a specific time range, up to and including an 
entire day. Multiple schedule elements can be defined for a specific day of the week, to represent 
several segments of a particular day (i.e. 8:30AM to 9:30AM, and 4:30PM to 5:30PM, to specify a 
one-hour period around 9:00AM and 5:00PM.)  All schedules are defined in the local time zone, 
which by default is the time zone of the recorder server machine. 

 Click Add New Schedule Element to define a new schedule. 

 Click Save to save the newly defined schedule. 

 

4.3.2 Group Setup 
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• Click the Group Setup icon on the top menu 

Permission Groups Setup allows an administrator to add, modify and delete permission groups. A 
permission group is a name associated with a validity schedule and the admin flag. Device 
permissions can be associated with a group once it has been created. None or several permission 
groups can be assigned to a user. 

A permission group is identified by a name, which is set in the Group Name field. 

The Schedule indicates the time period in which this Permission Group will be valid. If the current 
period is outside the schedule for a given permission group, then that permission group is not 
active. 

 
If this permission group needs access to the setup functions of this Recorder Service, then the 
Administrator Permissions box should be checked. Please note that if the permission group has 
administrator permissions, then it is valid at all times, regardless of any schedule. Thus the 
Schedule drop-down box and the Valid At All Times checkboxes will be disabled. 

If this permission group needs access to all devices on the system, then the All Device 
Permissions can be used in lieu of setting each permission individually on each device. 

4.3.3 User Setup 

 

• Click the User Setup icon on the top menu 

User Setup allows an administrator to add, edit and delete authorized user accounts from the 
Recorder Service. These user accounts are used by authorized operators to log on to a Recorder 
Service and operate a Recorder Client. 
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A user on the Recorder Service is identified by a unique username. The Username field should be 
filled in by the individual who is granted the permissions specified by this user account. 

 

 

The Change Password field is used to reset a password in the event that a user forgets or loses 
the password to this account. To change the password, fill in the Change Password field and click 
OK. 

NOTE:  When creating a user for the first time, the change password field MUST be filled in. 

IMPORTANT: When changing the password of the user who is currently logged in, that user 
must log out and log back in with the (new) proper credentials. This applies even in cases 
where a user changes his/her own password. 

The permission groups that have been configured on the Recorder Service are listed with 
checkboxes. To allow a user access to a specific permission group, check the box next to the 
appropriate permission group. If multiple permission groups are specified, their permissions are 
merged when permission checks are performed. If a user attempts an action which is permitted by 
one of their permission group memberships, but that permission group is outside of its assigned 
schedule and not an administrator group, then that action will be denied. 

The admin user cannot be modified or deleted, with the exception that a password change is 
allowed - this is highly recommended if the password is still the default. 

4.3.4 Video Device Setup 

 

• Click the Video Device Setup icon on the top menu 

In the Video Camera Device Setup dialog-box there are several options available for helping to 
get the proper configuration and layout for a particular camera.  
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After setting these options, click the Save button to commit any changes made, or to write the new 
camera settings to the Recorder Service.  

The Reset button will refill the original values specified for the currently edited camera, overwriting 
any changes made since this window was opened. The Cancel button will discard all changes, or 
stop the setup of a new camera. 

 

The Name field contains the text that will identify the camera to users, and will be displayed at the 
top of each video tile when this camera is viewed. The IP/Hostname field should be set to the 
network address of the camera. 

The Device Type is one of the camera types listed in the drop-down menu. Please refer to 
Appendix A.1 for a list of supported cameras. Note that by selecting Generic it will most likely be 
possible to also connect to cameras which are not in the list. In general, a complete path, including 
parameters, must then be entered in the field IP/Hostname.  

The Media Type will depend on the media type that the camera supports. 

NOTE:  Bandwidth is one of the primary considerations when selecting a media type. The media 
type(s) a camera supports and the bandwidth considerations that need to be addressed should 
determine which media type is used. 

• MJPG: Has the highest bandwidth requirement. Each frame is completely self-contained, 
ensuring that each frame is a complete image. 

• MPEG4: Lower bandwidth usage than MJPG, but in some cases worse bandwidth usage 
than H.264. Generally has lower processing overhead than H.264. 

• H.264: Has the lowest bandwidth usage given comparable quality and frame rate when 
compared to MJPG and MPEG4. This codec has the highest processing overhead. 
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The Username and Password fields are optional, and only need to be filled in if a camera requires 
a username and password to perform basic operations with the camera, such as to view or perform 
PTZ operations. 

In the Device Specific Options section, any atypical settings or preferences can be specified. For 
normal usage, most of these settings are not required, with the notable exception of the Maximum 
FPS option. 

The Multi-Channel Encoder option allows an administrator to specify which channel a camera 
operates on. This is used when a multi-channel network-enabled encoder is used to connect 
several analog cameras to the system. 

The Maximum FPS option specifies the maximum frames per second (FPS) a camera will operate 
at. Note that not all cameras support this capability, but where possible, it will be used. 

The Supports Physical PTZ option specifies whether pan-tilt-zoom commands are accepted by 
the camera. This support can come either from a connected PTZ unit or as a built-in feature of the 
camera. The Force PTZ Speed option overrides the server default speed for PTZ (if any), and 
prohibits the user from manually changing the PTZ speed. 

With the Stream-On-Demand option, it is possible to override the default setting for stream-on-
demand in the general setup. 

The Set Media Transport Type option specifies which transport protocol is used to send and 
receive media between the camera and the Recorder Service. This setting can be used to tweak 
communication reliability and performance, and should not be used unless a specific network-
related issue has been identified that can only be resolved by adjusting this value. 

NOTE:  By default, UDP is selected. 

• UDP: Most efficient transport protocol, but skips missed/omitted packets; this can lead to 
occasional smearing/streaking in images when using H.264 or MPEG4 if network reliability 
is degraded for a brief period of time. 

• TCP: Slightly less efficient than UDP, but missing/omitted packets are re-requested - 
routable via NAT. 

• HTTP: Roughly the same efficiency as TCP - routable via NAT and through firewalls that 
allow traffic over TCP port 80. 

4.3.5 Audio Device Setup 

 

• Click the Audio Device Setup icon on the top menu 
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There are 4 Device Types that can be selected. For the Vingtor-Stentofon Recorder, only device 
types AlphaCom and PassiveAudio are currently relevant. AlphaCom refers to AlphaCom call 
recording, while PassiveAudio refers to the Permanent Audio Stream from IP stations. 

 

In the Audio Device Setup dialog-box there are several options available for making the proper 
configuration and layout for a particular device.  

After setting these options, click the Save button to commit any changes made, or to write the new 
device settings to the Recorder Service. The Reset button will re-fill the original values specified 
for the currently edited device, overwriting any changes made since this window was opened. 

The Cancel button will discard all changes, or stop the setup of the device. 

The Associate Device checkbox and drop-down box allows the user to associate another device 
with an audio device, such that when the audio device is called to a media tile for live view (either 
via manual call or an alert, etc.) the associated device will be called to the same tile as well. If the 
associated device is an audio device, it will simply add to the list. If the associated device is a video 
device, it will replace any existing video in that tile. To associate a device, simply indicate that 
association is desired by checking the box and then selecting the device to associate from the 
drop-down box. 

When Associate Device has been selected a further option becomes available: Record 
Associated Device When This Device Records. 

 

In case the associated device is associated to an AlphaCom intercom station, this recording of the 
associated device will only be carried out when the device is the A-subscriber in the call. 

The Event Pre-Record Time drop-down box allows the user to select a time-constrained buffer for 
media on this device. If a device has an Event Pre-Record Time configured to a value greater than 
zero, the contents of this buffer will be placed into any event recordings made on that device. 
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Event recordings are all recordings started by alerts, or user-activated recordings. The pre-record 
buffer is contained within application memory; hence, performance may be affected when large 
recording buffers are utilized on too many devices. 

4.3.5.1 AlphaCom Devices 
It is possible to auto-define AlphaCom devices (please see section 4.3.6). 

 
How the intercom stations are defined depends on the recording requirement and the number of 
AlphaCom exchanges in the system. 

• Normally, any intercom station that needs to be recorded requires its own license: 
1190110131 or 1190110138. But in systems where there are many substations and few 
master stations, it is possible to only define the master stations. Only conversations which 
involve a defined master station will be recorded. This is also true when substations are 
connected to exchanges other than that of the master stations. 

• In the field URI/Address, enter ‘the directory number @ the IP-address of its AlphaCom’. 
Make certain that in an AlphaNet only a global numbering scheme is used.  

• If all AlphaCom exchanges in an AlphaNet are connected to the same recorder, in ‘Net 
Routing’ make a choice to record on ‘Incoming’ or ‘Outgoing’ AlphaNet calls, but do not 
select both. 
However, in the case where all master stations are connected to only 1 of the exchanges, 
both the ‘Incoming’ and ‘Outgoing’ flag must be selected, as all recording is done from the 
single exchange. In such a case, only 1 license, 1190110120, Vingtor-Stentofon Recorder - 
AlphaCom Recording Module, is required, which will then connect to the exchange with the 
master stations.  

• The Username is the recorder name as defined in AlphaPro. Username ‘recorder’ is 
preferred. 

4.3.5.2 Passive Audio Devices 
Device Type PassiveAudio concern audio streams from a Vingtor-Stentofon Turbine station. 
Such a station can be enabled to stream audio to a specific UDP port. Enter the UDP port number 
in the field Local UDP Port. Note that each stream must have its own UDP port. Convention is to 
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only use even numbered ports. The fields Username and Password have no relevance for 
Passive Audio stream devices. 

 

4.3.5.3 Bulk Intercom Setup 
 Click Add Bulk to configure bulk intercom 

 
 

The Bulk Intercom Setup dialog-box is used to add a range of devices which are located on 
AlphaCom intercom systems to the Recorder Server. This can speed deployment significantly. The 
use of this dialog-box is closely-related to that of the single device setup dialog-box. Instead of a 
name, there is a Name Root. In the above example, this name root is AlphaCom Station. This 
means that every device that is created with this bulk setup dialog-box will have a name of the form 
AlphaCom Station ### where ### is the station number. 

The Device Type drop-down box has the types SIPvault and AlphaCom available, and is used to 
select which device types are being created. Note that SIPVault is not used. 
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The next field is labelled according to the necessity of the system being connected to. For more 
information, see Appendix A.5 on the AlphaCom system as applies to the type of devices that are 
being created. As a brief example however, the field should contain the ‘common’ portion of the 
device’s URI. If a single AlphaCom device’s URI is ‘1005@192.168.1.1’, then the value entered 
here would be simply ’192.168.1.1’. 

The Username and Password fields are to be filled out as appropriate for the service/exchange 
being connected to. For details, see Appendix A.5 on the AlphaCom system as applies to the type 
of devices that are being created. 

The First Station and Last Station fields are used to define the format and range of the device 
identifiers. They must have the same length, and the first station value must be less than that of 
the last station. In the above example, 50 stations will be created, with station numbers 001, 002, 
003… 048, 049, and 050. 

 

4.3.6 Third Party Connection Setup 

 

• Click the Third Party System Connection Setup icon on the top menu 

Third Party System Connections are used to communicate with external systems that are not (in 
and of themselves) a media source. Currently only ‘AlphaComSystemConnection’ is used.  
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It is not a requirement for the correct operation of the recorder to define an (or several) AlphaCom 
exchange(s). The connection will only be used to define AlphaCom intercom stations automatically.  

Provide a meaningful name for the connection. 

When the box Autopopulate Devices is checked, any device which is not known to the recorder 
will automatically be added when there is a recorded call to/from that station. Note that this first call 
will not be recorded - at this time the station will only be added to the system. Subsequent calls will 
be recorded. 

Normally the station name will be set to the one in the AlphaPro defined display text. This name 
will only be set once and will not follow changes in AlphaPro unless the box Keep Device Names 
Synchronized with Third Party System is checked. 

• Enter the IP address of the AlphaCom server in the field Host 

The recorder assumes that the Username of the recorder is defined as ‘recorder’ in AlphaPro. This 
can currently not be changed. 

Select the relevant recording schedules. These will be used as a template. See section 4.3.10 if 
some of the automatically defined recording schedules need to be altered. 

Note that this method of adding intercom stations to the recorder does not take into account that 
substations may not need to be defined. If such a substation is added inadvertently it can be 
deleted using Audio Device Setup. 

In an AlphaNet, it may happen that the intercom station gets defined with the wrong AlphaCom IP 
address. This is due to the fact that AlphaCom reports all stations that are to be recorded as if they 
are connected to it. The fact that the IP address appears to be wrong does not affect correct 
operation of the recorder as it uses the directory number as the main identifier. By making certain 
that during the definition phase only calls are made within a single exchange, this IP address mis-
definition can be circumvented. 

4.3.7 Salvo Setup 

 

• Click the Salvo Setup icon on the top menu 

Salvo Setup allows an administrator to create, modify and remove salvos from the Recorder 
installation. Salvos are used to perform a device call on multiple devices using a single operation. 
Salvos can be called by a user with sufficient permissions (‘live monitor’ permission). Salvos can 
also be called by the linking system, which is available on configuration options such as triggers. 
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The first field is the Name to display to the user. The next series of options are a selection of 
Devices that should be displayed to the user. The first device entered in this list will be displayed 
in the first alert tile on the Recorder Client. As many devices as possible will be displayed to the 
user, based on the number of alert tiles available for display on a particular Recorder Client. If an 
insufficient number of alert tiles are available for display, this list will be truncated as needed to 
display the maximum number of devices to satisfy the salvo call. 

4.3.8 Trigger Setup 

 

• Click the Trigger Setup icon on the top menu 

Triggers allow an external system which is connected via the Vingtor-Stentofon Recorder API to 
create alerts, which are distinct notifications that are sent to a Recorder Client to be displayed and 
acknowledged by a user. 
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The Name field is the distinct name that this trigger will have. If this trigger will eventually generate 
alerts, then this name will be used as the name for the alert as well. 

The Priority field determines where alerts created by this trigger will fall in the list of alerts on the 
Recorder Client. A higher number indicates a more pressing need for action by a user. The higher 
the number, the more reddish the color that will be displayed. The lowest priority is green, followed 
by a yellow-green combination, then yellow for the middle priority, then orange for an elevated 
priority, and lastly, bright red for the highest priority. 

Active Schedule indicates when this trigger can be activated. The times defined in the schedule 
are the times when this schedule will be active. Any times not specified will cause this trigger to not 
be activated when signaled via the API. A trigger that is not currently active will also not generate 
an alert on the Recorder Client whenever it is signaled via the API. 

If this trigger should also notify users when it is activated, check the box Make Trigger Create An 
Alert, Requiring User Attention. 

If this trigger should also require a comment (minimum length: 5 characters) prior to being 
acknowledged by a Recorder Client user, check the box Require Comment by User When 
Acknowledged. 

Text Displayed To User (Optional) is a block of text that will be displayed to the user when the 
user looks at an alert generated by this trigger. This text can be used to deliver timely information 
related to this trigger, such as a phone number to call, person to notify, and action to perform, etc. 

If this trigger should not be deleted, but instead should be disabled for now, check the Disabled 
(Prevents User Triggers and Trigger Links) box. This should be used when a deletion is not 
warranted, or during a pre-configuration phase of the setup when a trigger shouldn't be active, but 
should be created for future use. 

When configuration of this trigger is complete, click the Save button to continue. If, when modifying 
a trigger, a mistake is made or the original settings are desired, click the Reset button. If no 
changes are needed, click the Cancel button to return to the setup screen. 
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To modify links in the trigger configuration: 

• Click Modify Links  

 

Any trigger can have zero or more links associated with it at a time.  

• To add a new link, click the Add Link button.  

• To modify an existing link, click the link in the list, then click the Modify Link button.  

• To remove an existing link, click the link in the list, then click the Remove Link button. 
When adding or modifying a link, the left-hand pane will be disabled. 

Link Name is not typically displayed to a user, so writing a descriptive name indicating what this 
link will do is encouraged. 

Link Type will be displayed, but cannot be modified. This link type is automatically filled in based 
on the type of device being linked. 

Links, like triggers, are scheduled activities that are activated under the Active During Schedule 
option. A link will not be used if a schedule does not indicate that the link should be active at the 
time the trigger is signaled via the API.  

Condition defines what needs to occur for this link to be activated. This specifically relates to the 
condition that is met by the linked device, so in the example above, the trigger needs to meet the 
condition specified in order for this link to be activated. 

Resulting Action is the type of action to perform when the condition is met. Things such as calling 
a device to workstations, activating another trigger or calling a salvo to workstations are available, 
and are configured on a per-action basis. 

When all required information has been provided, click the Save button. If no changes need to be 
made, or if no new link is to be created, click the Cancel button. 
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4.3.9 Group Permissions Setup 

 

• Click the Group Permissions Setup icon on the top menu 

 

At the top of the window is the name of the Permission Group that is currently being edited. 
Below that is a Server drop-down box defining which server the permissions for this group are 
being adjusted on.  

If the permission group has admin permissions, then members of the group have all permissions to 
all devices, and therefore the adjustment options will be disabled with the exception of the Close 
button at the lower-right corner of the window. 

If the permission group does not have admin permissions, then for each device configured on the 
Recorder Service an entry will be listed, alphabetically, in the device list. To set the permission 
level for a specific device, scroll until the device to be modified is visible in the list. The Toggle 
button will alternatively check and uncheck all of the permissions for that device for convenience 
when installing/configuring the software. 

All permissions to all devices on this particular server can be granted to a group by checking the 
All Device Permissions box in the upper-left corner of the window. This will disable the individual 
device permissions list.  

As a minimum, a user must have permission to monitor before setting any other permissions, so 
check the Monitor box to enable additional permissions. Monitor will only allow the device and its 
state to be listed in the device list. 
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The Live View permission allows the user to view a live stream from a camera or listen to an audio 
device/conversation live. 

The Record permission allows the user to create user/event recordings on-the-fly by performing a 
record operation as described in section 5 User Manual.  

The Playback permission allows the user to play back recordings (scheduled and user/event 
recordings.)   

The PTZ permission allows the user to modify the pan, tilt and zoom of a camera.  

The Set Presets permission allows the user to set a numeric pan, tilt and zoom preset for the 
camera. 

The Export permission allows the user to export audio or video clips. 

To save the changes to device permissions for a given server, click the Save Changes button at 
the bottom of the window.  

• When done, click the Close button. 

4.3.10 Device Schedule Recording Setup 
Recordings Setup allows an administrator to associate one or more schedules with a particular 
device. These schedules define when a particular device will be recorded (scheduled recording). 
This setup dialog-box defines the automated scheduled recording process on the Recorder 
Service. 

• Click the Device Schedule Recording Setup icon on the top menu 

  

• To configure the scheduled recordings for a particular device, first select the device in the 
Select Device drop-down menu at the top of the dialog-box. The available and selected 
schedules will be displayed on-screen for this device representing the current recording 
configuration for the selected device. 
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• To add a schedule to the list of schedules used to determine when this device will be 
recorded, click a schedule in the left pane to select it, then click the > button. 

• To remove a schedule from the list of schedules used to determine when this device will be 
recorded, click a schedule in the right pane to select it, then press the < button. 

The >> and << buttons can be used to move all schedules between the Available and Scheduled 
lists. 

When a schedule is added or removed from the list of schedules used to determine when this 
device will be recorded, this information is immediately updated on the Recorder Service. 

4.3.11 System Setup 
• Click the System Setup icon on the top menu 

 

System Setup allows the administrator to configure system-wide settings in one location. 

The Default Media Sources to Stream-On-Demand setting defines whether stream-on-demand 
is enabled for this Recorder Service. This setting is enabled immediately when the checkbox is 
selected or deselected. 

The Alarm On Media Loss setting defines whether the Recorder should produce an alarm to 
indicate media loss when the connection between the NAVR and the device is broken. This is only 
for active connections, either those which are being streamed at all times, or those which are 
stream-on-demand, but which break during a period of demand.  
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The Allow live intercom monitoring when not recorded setting defines whether users who have 
permission to monitor an intercom endpoint can monitor that endpoint when it is not configured to 
be recorded. This is due to special privileges in some jurisdictions regarding voice 
communications. By default, a user cannot listen to an intercom conversation live that would not be 
recorded and available for review. If it is desirable that a user with Live Monitor permission for a 
given intercom be allowed to listen to that intercom even if the intercom is not configured for 
recording, then this box should be checked. Otherwise, the given device will appear to remain 
inactive on the user’s device list unless it is both active, and being recorded. 

The PTZ Defaults setting is used to create a server-wide default speed multiplier for PTZ cameras 
between the values of 0.1 and 3.0. When this setting is specified, PTZ speed cannot be modified 
during runtime. The PTZ default setting may not show on the client until the camera in question 
has been closed and re-called. 

The Storage Trimming section comprises two subsections: Activity Logs and Recordings. 

The Activity Logs section designates how long logs of activities on the server, such as video calls 
from a client, connections to IP devices, user login and logout, and configuration changes by users 
are retained on the NAVR. By default, all of these logs are trimmed when more than 30 days old. 
Successful media requests and device connections can occur quite often depending on operator, 
network, and recording schedule activities. Therefore, these are trimmed from the log after 2 
weeks by default. This log trim is performed daily, at or just after the specified time. It is best to 
perform this trim at a time when system activity is expected to be low. 

The Recordings section designates how long recordings are retained on the NAVR. The first 
option is to delete media AND database records older than a given number of days. This is used to 
prevent the NAVR media repository and database from filling up. The next two options allow the 
administrator to decide to delete the media (but not the database entry) associated with event 
recordings and/or scheduled recordings older than a given number of days. Database entries will 
indicate that the recording has been deleted, but will remain to describe the recording. 
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4.3.12 Connection Restriction Setup 
• Click the Connection Restriction Setup icon on the top menu 

 

The Connection Restriction Setup tab can be used to prevent API and video connections to the 
NAVR from other-than-allowed IP addresses.  

The function is enabled by checking the Enforce IP address connection restrictions box. 

Note that all IP addresses from which you expect legal connection requests must be added. 

 

4.4 Reports Menu 
The Reports menu option is only visible to users who are members of the administrator group. 

The time can be selected in the local time or the server time, which can be useful if the server is in 
a different time zone. 

Only users who have logged actions are displayed in the Logged Users list. It is possible to filter 
on granted or denied permissions. 

• Click Reports on the top menu 
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4.5 Direct recording 
It is possible to use an HTTP-command to start recording Video cameras and Passive Audio 
Streams. It is not possible to start the recording of conversations inside the AlphaCom in this way. 

http://RecorderServerIPAddress:MJPEG_HTTPport/STARTREC?dev=CamOrStream&duration=xx 

• The MJPEG_HTTPport default number is 8084, but can be changed in the recorde5r setup 
dialog. 

• CamOrStream is the device name given when the camera or audio stream was defined in 
the recorder. 

• Duration is the to be recorded timespan in seconds  

The recorder uses basic authentication. With Google Chrome it is possible to pre-empt 
authentication and use a format as following: 

http://admin:12345@127.0.0.1:8084/STARTREC?dev=MyCam&duration=60 

  

http://RecorderServerIPAddress:MJPEG_HTTPport/STARTREC?dev=CamOrStream&duration=xx
http://admin:12345@127.0.0.1:8084/STARTREC?dev=MyCam&duration=60
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5 Operating Procedures 

• Start the Playback and Configuration Client. 

5.1 File Menu 

5.1.1 Logging On 
In order to log on: 

 

• Select File > Logon 

 

• Select the Server to connect to 

• Enter the Username – default: admin 

• Enter the Password – default: 12345 
When there is a change of operators, the currently logged-in operator can use File > Logoff to log 
out, after which the new operator can log in. 

The Playback client may be configured with details of multiple servers. If this is the case, first 
select the server to connect to. 

5.1.2 Set Time Zone 
• Select File > Set Time Zone 

The time zone selection dialog-box will be displayed. 
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This determines which time zone is used when displaying times to the user for purposes of current 
time, search, and playback. The options include the client’s Local Time, Universal Coordinated 
Time (UTC), and an option to use an arbitrary time zone. The current time in the selected time 
zone will be displayed in the lower-right corner of the NAVR Client. Hovering the mouse cursor 
over this time will cause a tool tip to be displayed with the name of the currently selected time 
zone. 

After logging in, the top menu will display new options: Actions, Setup, Reports, New Window. 

 

 

5.2 Actions Menu 

 

5.2.1 Clear Selected Tile 
This option will remove the video from the selected video tile. This option only works for the 
selected camera on the main window - new windows that are created do not support this feature. 

5.2.2 Close All Media Streams 
This option will remove the video from all video tiles on all windows. This option does not send any 
information or commands to the Recorder Service, and its only function is to clear all windows of 
any video with a single command. 



 
Recorder 2.0 
 

 

 

 
38  Vingtor-Stentofon Recorder 2.0 Manual 
 

5.2.3 Automatically Call Passive Devices When Online 
A Passive Video Device may start streaming video at any time. Enabling this option will ensure that 
when such a device does so, the video from it will be automatically called into Alarm Tile 1. If 
another device is associated with the passive device, then it too will be automatically called into 
Alarm Tile 1. 

5.2.4 Play Alert Tone When Auto Calling Passive Device 
This option will alert the operator when a passive video device is automatically called to Alarm Tile 
1.  

5.3 Setup menu 
The Setup menu is only available when the user has logged in as an administrator. Most of the 
settings are described in section 4.3. 

5.4 Reports menu 
The Reports menu is only available when the user has logged in as an administrator. See the 
description in section 4.4 for details. 

5.5 New Window menu 
The New Window menu item has two options: Live and Recordings 

Live creates a new window that is nearly identical to the main NAVR Client window. Once created, 
this new window can be relocated, maximized, restored and can display all content that's 
displayable on the main NAVR Client window. 

NOTE:  A new window has some specific features and restrictions, as noted below: 

• A new window cannot access any of the menu options at the top of the screen. 

• A new window cannot see the status bar at the bottom of the screen. 

• The media tiles on a new window will not have the New Window icon available. 

• Devices can be dragged-and-dropped between any window and any video tile. 

• When the user logs out, all new windows will be closed as well. 

Recordings creates a new window used to monitor recordings only, and which does not have 
access to live view devices and salvos, or alert devices and triggers. 

5.6 User Interface 
The main user interface of the Playback Client consists of a left-most section that contains 
Devices, Alerts, Views, and PTZ control and interface tabs. 

The left-most section containing the tabs can be accessed by moving the mouse cursor over one 
of the tabs. The tabs will expand to extend the visibility of the highlighted tab so that additional 
content can be displayed. Click the Close Menu button at the bottom of the window to contract the 
tabs and thus create more space for the video tiles. 



 
 
 

Recorder 2.0 
 

 

 
Vingtor-Stentofon Recorder 2.0 Manual  39 
 

5.6.1 Devices Tab 
The Devices tab in the upper-left corner of the main user interface contains a device list. It is a list 
of all devices configured on the connected Recorder Service for which the current operator has 
some rights. The tab allows several ways to reference devices and view them.  

 If the colored indicator next to a device is green it means 
the device is active, is currently providing media to the 
NAVR, and is available for live monitoring.  

If the colored indicator next to a device is red, it means the 
device should be providing media to the NAVR, but is not. 
This indicates an error state.  

If the colored indicator next to a device is gray, it means 
the device is inactive and will not be providing media at this 
time. 

 

 A device for which the operator has Monitor but not Live 
View rights is indicated by the addition [No Live] behind 
the device name. 

 

 

 

 
NOTE:  If a device, or the system, is configured to use the "stream-on-demand" feature, then any 
devices set using this feature will display as the inactive/gray-colored state. This is normal and 
expected as a connection to the device is only made when a request to view video is made by a 
NAVR Client, or a scheduled recording occurs as configured for the Recorder Service. When this 
connection is made, the icon for that device will turn green, as it is then known that the device is 
active. 
AlphaCom devices will display as unknown/gray regardless of stream-on-demand setting, unless 
actively recording audio, in which case they will display as active/green to indicate the ability to 
monitor live media. 

A user can filter the devices displayed in this list to just those devices that are part of a specific 
connection. To do this, click on the drop-down box and select the connection to view. The top 
option, --- All Connections --- stops any filtering. 

A user can filter the devices displayed in this list to just those devices that contain a specific text 
grouping. To do this click in the text area above the device list and begin typing. The device list will 
dynamically update with only those devices that contain the search criteria. 
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Each entry in the device list represents an interactive item on the Recorder. 

5.6.1.1 Video and Audio Tabs 
To view a video or audio device, one or more of these actions can be performed: 

• Press-and-hold the left mouse button on a video or audio device entry, drag the cursor to a 
media tile, then let go of the left mouse button. 

• Double-click a video or audio device entry. If there is a media tile that is unfilled on the 
window, the media device will be called to that media tile. If all media tiles are filled, then if 
a tile is selected (which is identified on-screen by a colored, highlighted border) the media 
device will be called to the selected tile. 

Calling a video device to a media tile that is already displaying a media device will replace the 
existing displayed video device with a new one. 

Use of Audio devices is similar to that for video devices. To perform live monitoring, drag-and-drop 
the device onto a media tile. A live audio playback tile will display the following: a close button to 
close that particular audio monitor, the name of the device, and a power meter for current audio. 
The purpose of this power meter is to help a user distinguish the correct audio source when 
hearing a sound while multiple live audio sessions are simultaneously active.  

Multiple audio sources may be put into the same media tile. Clicking the close button next to a live 
audio source will stop the monitoring. Putting a live audio source into a tile that already contains an 
identical source will shut down the original and start up the replacement. 

Audio devices may have another device associated with them. If they do, then any method which 
calls an audio device into a tile, will also call the associated device (be it video or audio) to that 
same tile. 
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The Recorder allows every media tile to contain none or one live video stream and none to 
unlimited live audio streams. If a tile contains only video or audio, then it will display only video or 
audio. If both are being utilized, then the tile will show video in the top ¾ and a list of audio devices 
in the bottom ¼. A scroll-bar will appear if the list of audio devices becomes too large to be 
displayed. 

Dragging media from one control panel with more than one device in it into another will cause all 
devices in the first tile to be called to the second tile as well. This will cause a replacement of 
video, and the addition (but not replacement) of audio devices in the new tile. 
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Playback works the same as live media while the following should be noted: 

• If two recordings have different codecs, attempting to concatenate them for playback by 
selecting both and then clicking the Review Selected button may generate poor audio 
playback quality or ‘junk’ audio. 

• Only a single media recording can be played back at a time. 

• Recordings that are very short, and have an error associated with them will not be logged 
or retained by the Recorder. This may occur when the media source is set to record, but 
does not provide data to be recorded. 
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5.6.1.2 Salvos Tab 
A salvo is a logical item that, when activated, will display one or more cameras in separate tiles 
through a single activation. The operation of the Salvos tab is nearly identical to that of the 
Devices tab, with the exception that salvo devices will only be called into tiles that can accept an 
alert device call. 

5.6.2 Alerts Tab 
Alerts notify a user that a significant event has been generated by the 
Recorder, and also provides a simple interface for basic comments 
and alert acknowledgment. Alerts are generated through use of the 
Trigger system (see section 4.3.8). 

5.6.2.1  Active Tab 
This tab will display zero or more active alerts which have not yet been 
acknowledged. 

Alerts will be listed in order of priority, with level-5 priority being the 
highest (red) and level-1 priority being the lowest (green.) 
To acknowledge an alert, double-click anywhere on the alert text. A 
window will be displayed indicating any additional actions the 
administrator deems necessary. If required (or if prudent) type in a 
short comment describing any actions performed. After the alert is no 
longer needed, it can be acknowledged by clicking the Acknowledge 
button. This will also remove the alert from the list on all Playback 
Client workstations. 
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5.6.2.2 Trigger List Tab 
This tab will display all triggers configured on a particular recorder. The main features of this list 
are the ability to filter by name and/or connection, and the ability to see which triggers are currently 
not disabled on the system. A user cannot interact with the triggers listed, so this tab is primarily for 
reference only. 

 

At the bottom of this tab is a drop-down box indicating the number of alert tiles that can be 
displayed. If this number is greater than or equal to the number of tiles on-screen, then all tiles will 
be capable of handling alert call-ups when an incoming alert is received and the optional device 
call-up link exists. If this number is less than the number of tiles on-screen, then only the selected 
number of tiles will indicate they are capable of handling alert call-ups. 
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5.6.3  Views Tab 
 
The views tab allows the user to switch between views, allowing for 
additional flexibility both in the number and configuration of tiles presented. 
The Favorites list at the top contains the last 3 views selected by the user. 
To change the view of the tile grid displayed in the window click any view in 
the list. Media tiles are identified by the numeric reference listed in the 
selected view. When switching views, the devices that were on display in 
the previous view will be automatically repopulated in the new view, 
relative to the numeric reference from the previous view. 

 
 
 
 

 
 
 

5.6.4  PTZ Tab 
The PTZ tab allows a permissions-enabled user to pan, tilt, zoom and call presets on a selected 
camera. A camera must be selected for the PTZ control to be enabled and displayed. If a specific 
camera view is selected to review video, the PTZ control will not be displayed, and instead, will be 
replaced with the Playback Tab. 

The top row of selections is to decide whether PTZ should occur digitally or physically. Physical 
PTZ uses motors or other capabilities supported by the camera to adjust the camera or its lens as 
directed. Digital PTZ performs on-screen adjustment of the existing image to produce the desired 
result where possible. Digital PTZ cannot exceed the boundaries of the image, and as the zoom 
level is increased the detail of the image may become grainy or fuzzy. 

To adjust the pan or tilt of the selected camera, click the up, down, left or right arrow. To adjust the 
zoom level of the selected camera, click the plus (+) or minus (-) button. The speed modifier is a 

slider that allows the user to increase or decrease the amount of 
adjustment that occurs during PTZ operations. The four preset buttons 
(Slow, Normal, Fast and Very Fast) are mapped to this slider for quick 
access to popular speeds. To use one of the speed preset buttons, click 
the desired button: the slider will move to the appropriate location on the 
slider bar. To manually adjust the speed for greater fidelity, click and hold 
the slider icon, then drag the slider icon to the left or right. A speed of 1.0x 
is considered regular speed. 

NOTE:  When performing PTZ operations it is recommended that these 
operations be tested to see how much lag there is between when the 
button is clicked and when a visible action occurs with the camera. Due to 
external influences such as network connectivity, input lag, and camera 
speed, it is possible that a command could take several seconds to 
execute. 



 
Recorder 2.0 
 

 

 

 
46  Vingtor-Stentofon Recorder 2.0 Manual 
 

In the Presets box, there are a series of numbered buttons which allow a user to quickly call a 
particular preset. A preset is specific to whether the Digital PTZ or Physical PTZ radio button is 
selected, so ensure that the proper radio button is selected prior to performing a PTZ action. To set 
a particular preset, first use the controls described above to adjust the camera position. Once a 
proper location and zoom level has been determined, click the drop-down box containing camera 
numbers and select the preset number to assign. Click the Set Preset button to send this new 
preset position to the Recorder Service, which will commit the change. Note that not all cameras 
can support this option. 

5.6.4.1 Joystick Support 
If a standard joystick or other game controller conforming to the USB joystick standard is 
connected to the Playback Client machine, that joystick may be used to interact with the Recorder. 
Specifically, the first two buttons on the controller will move the ‘selected tile’ between all on-screen 
tiles and will function as ‘next’ and ‘previous’ buttons respectively. 

On a selected tile, the joystick may be used to perform physical or digital PTZ operations for pan, 
tilt, and zoom. Buttons on the controller starting at 3 may be used to call presets on the camera in 
the selected pane, starting at preset 1.  

• Pan is set by the X or RotationX value of the controller. 

• Tilt is set by the Y or RotationY value of the controller. 

• Zoom is set by the Z or RotationZ value of the controller. 

• Select Next Frame is triggered by pressing Button 1 on the controller. 

• Select Previous Frame is triggered by pressing Button 2 on the controller. 

• Call Preset 1 is triggered by pressing Button 3 on the controller (Preset 2 with Button 4, and 
so on). 
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5.6.5 Playback Tab 
The Playback tab is only displayed in a Playback window. To bring up a 
playback window: 

•Select New Window > Recordings from the main menu  

When in a Playback Window, live cameras and alarms cannot be 
accessed, only Playback, Views, and (digital) PTZ are accessible. 

Search 
To start a search:  

•Select a device from the Enter Search Criteria drop-down box 

•Select a date from the calendar and time from the time box 

The radio buttons NAVR Local and User Selected designate the time 
zone on which the date to search is based. NVR Local is the local time 
zone of the Recorder which is being searched for recordings. User 
Selected is the time zone which was configured for this client. 

The Event Recordings Only checkbox allows the user to better scope 
the search by indicating that only event-based recordings (as opposed to 
scheduled recordings) should be searched. To perform the search:  

•Click the Search button 

 

Adv. Search 
If an advanced search is desired (more filtering):  

• Click the Adv. Search button for advanced search form 

 

The left side of the advanced search dialog-box is identical to the search dialog-box displayed in 
the main playback tab. However, after the Search button is clicked, the Found Recordings 
quantity will update to display how many recordings were found given those search constraints. On 
the right side, options for filtering by caller and participants can be enabled, depending on whether 
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those options are applicable to the recordings resulting from the search. As filters are applied, the 
number designated by Filtered Recordings will be updated in real time. To use the recordings 
that resulted from the search with no filtering, simply click the Use All Recordings button. To use 
only those recordings that match filters designated on the right side of the form, click the Use 
Filtered Recordings button. This will close the dialog-box and list the recordings as the Search 
button on the main playback tab would have done. 

After a moment, a list of recordings will be displayed. This list will indicate the start time, the end 
time and whether the recording has been deleted due to the purging routine on the Recorder 
Service.  

Review 
To review a timeframe, select the recording and click Review or double-click the recording. If a tile 
is currently selected, the replay media will display in that tile, with information regarding 
participating intercoms or other notes as applicable to this recording. If no media tile is selected, 
but one of the tiles is empty, the replay media will be displayed in that tile. If these conditions are 
not met, a notification will be displayed informing the user as to why media is not being displayed.  

Sync. Review 
Sync. Review provides the possibility to play back up to 4 streams at the same time, synchronized 
on the time that they were recorded. Due to possible differences in coding and transmission delays 
of video and audio this is not a guaranteed exact lip-synchronized playback. 
First select the main recording of interest for playback and click Sync. Review. A new dialog-box 
will open where a new recording source can be selected. Upon selection, all recordings of that 
source which at any point overlap the recording time of the first selection will be listed.  

• Select the required recording and click the > button recording.  

Repeat this if required. 
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Auth 
Clicking the Auth button will request that the server authenticate the digital signature on this 
recording to ensure that it has not been tampered with during storage. One of three answers will be 
returned:  

• authentic (the digital signature indicates that the file has not been tampered with),  
• inauthentic (the digital signature indicates that either the file or the digital signature has 

been modified)  
• not able to be authenticated.  

MJPEG recordings and those recordings that are currently being made cannot be authenticated, 
and will therefore return the third result. This is NOT an indication that they have been tampered 
with, merely a statement that their authenticity cannot be verified. 

Export 
Clicking on the Export button while one or more video recordings are selected will cause an AVI 
formatted video file to be exported in the following manner: 

 
 
The user can then select a sub-portion (if desired) of the total recording duration, and then select a 
location for the file to be exported to. This location defaults to the user’s PC desktop. To change 
this setting, utilize the Browse button. Once this value has been changed, the new location will be 
used as the default path until it is changed again. 
The file name for the export will consist of the device name in question, as well as the start and 
end times of the clip. Clicking the Export button will start the export process. After a brief pause, a 
progress bar will indicate the status of the current export. If an error occurs at any time, this will be 
displayed to the user, and the export terminated. The export may be cancelled at any time during 
export, which is performed in real time. 
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If a single audio recording is selected, then clicking the Export Selected button will display a 
different media export option. In this case, the entire recording will be exported, and encrypted 
along with a digital signature to verify authenticity as follows: 

 
Select a location and name to save the exported file to, using the browse … button next to the 
Save As… text field. 

The Encryption Key is used to encrypt and decrypt the recording file. The key is case sensitive, 
and is necessary to play back this exported recording. All recordings are encrypted with AES256, 
using a FIPS 140-2 certified implementation of that algorithm. 

Checking the box Copy exported audio player to the target directory will cause the software 
necessary to play back this recording to be copied to the same directory as the recording when the 
export is complete. For information on how to use that playback, please see section 5.7. 

When the Download button is clicked, the client will download the encrypted audio export from the 
Recorder. After the download is complete, the public key fingerprint of the Recorder will be 
displayed to the user. The reason for this is that the user, when playing back the exported audio at 
another location, can check that the fingerprint of the public key which is used to verify the 
recording at that time matches the Public Key Fingerprint supplied by the server during export. 
This confirms that the signature on the exported recording is not only valid (indicating that it has 
not been tampered with), it was also validly signed by the server that it originated from, and not 
replaced with a validly signed audio export from another source. 

Playback Controls 
The buttons at the bottom of the Playback tab allow for control over the playback of the selected 
media tile. The << (Rewind) button will set the playback speed to negative, allowing for reverse 
playback. The || (Pause) button will stop playback on the current frame. The > (Play) button will set 
the playback speed to 1 and begin or resume playback. The >> (Fast Forward) button will increase 
the forward playback speed. The drop-down box with values 1, 5, and 15 is used to set how many 
minutes the skip buttons will skip the recording playback, either forward or backward. 

5.6.6 Media Tiles 
A media tile is the primary video host control for the Playback Client. Each video tile is capable of 
displaying both live video and replay/recorded video. 

Once a media tile is displaying live media, the 
buttons in the upper-right corner of the video tile 
become accessible. To activate any of the icons, 
double-click the appropriate icon. 
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• Clicking the icon with four arrows pointing outwards will open a new window and pre-
populate the new window with the media in the selected tile. 

• Double-clicking the icon with a simple circle begins or ends a user-initiated recording 
session (also known as an event recording), which lasts for a maximum of 1 hour. All 
devices that are currently in the media tile will begin recording, and the circle will turn red 
for the duration of the recording, so long as any device in the tile is still recording.  

If the circle is red, then double-clicking on it will stop recording any device on the tile that is 
currently being user-recorded by that tile. Removing a device from the tile will stop the user-
recording for that device. 

AlphaCom can be set up such that the RTP streams of conversations between IP stations are 
recorded separately. During playback it is then possible to mute one side of the conversation by 
clicking the relevant button. 
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Recordings which involve an analog station, conferences or group calls always result in a single 
(mixed) RTP stream from AlphaCom. 

 

5.7 Standalone Playback Client 
The Standalone Playback Client is used to play back secure audio exports from the Playback 
Client Secure Audio Export functionality. The Standalone Playback Client executable is 
Nvr2StandalonePlabyackClient.exe, and can be found in the Vingtor-Stentofon Recorder Client 
installation directory, or also in any location where it has been placed during the secure export 
process. 

To load a recording, go to the File menu, and select Load Recording. Select the recording file, 
and click the Open button. Enter the decryption key when prompted. This must match the input 
used for encryption when the export was performed. 

Note that the device name from the NAVR that generated this recording is listed, as is the start and 
end times of the recording. These times are given in the time zone specified by the Time Zone 
drop-down box. This will default to the local time.  

The Notes field will display any information accompanying the recording.  
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The Authenticate Recording button will check the digital signature of the recording against the 
public key that was exported with it. This will result in a determination of Authentic, NOT 
Authentic, or Unable to be authenticated. A result of NOT Authentic indicates that the digital 
signature is not authenticated with the current recording, indicating possible tampering. A result of 
Unable to be authenticated indicates that there was an issue authenticating the recording, 
indicating only that authenticity cannot be determined. If authentic, the fingerprint of the public key 
used to authenticate the recording will be displayed. The purpose of this is to confirm that the 
public key fingerprint displayed matches that which was displayed during the export process. 
Making a match confirms the source of the recording. 

Once a recording is loaded, simply click the Play button to start playback. The current time and 
playback rate will be indicated along with a power meter showing the average and maximum 
loudness of the current audio. Progress of the recording will also be indicated by the slider control 
above the Current Time text. 
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A Audio and Video Sources 

A.1 Supported Cameras 
NOTE:  The following hardware has been tested. This list is not exhaustive of all camera hardware 
that is capable of working with these settings, but represents a subset of similar camera hardware 
that is usable with the Recorder platform. 

Camera type Note 

AlertWerks SCA201-NTSC connected to a ServSensor V4E 

Arecont AV2100M 

Axis - V2 In general this includes models with three numbers in the model 
description (i.e. 213, 215) 

Axis - V3 In general this includes models with four numbers in the model 
description (i.e. M1054, Q1775, and M3204) 

Generic See Appendix A.2 for details and description – this selection should be 
made for the Vingtor-Stentofon CP-CAM 

Panasonic Tested with WV-NP502, WV-NS202. Vingtor-Stentofon Recorder should 
work for all Panasonic cameras capable of RTSP media transmission 

Passive See Appendix A.3 for details and description 

Samsung Tested with model SNV-608RN. Only supports RTSP (H264 and MPEG4) 
media 

SiquraFixed Tested with model FD820M1. Supports MJPEG, H264, and MPEG4 
streams from fixed (non-PTZ) Siqura cameras. 

A.2 Generic Cameras 
The generic camera type is used to support cameras, encoders, and other video sources that may 
not be specifically supported by the Recorder. A generic source requires a name, as with any other 
source.  The major difference between specific Camera Types and the Generic type is that the 
generic type must be supplied with a full media URI.  This URI will generally be supplied in the 
documentation for a capable camera or encoder. 

If the selected media type is H.264 or MPEG4, the URI should be the path to be accessed to the 
RTSP process.  This information should be contained in the manual for the camera in question.  If 
the media transport type is UDP, then RTSP will occur over TCP port 554 and the media will flow 
over a negotiated random UDP port.  If the media transport type is TCP, then RTSP will occur over 
TCP port 554 and media will flow over that same connection.  If the media transport type is HTTP, 
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then RTSP and the media will both be tunneled over a series of HTTP connections over TCP port 
80. 

 

If the selected media type is MJPG, the URI should be the path of the JPEG image or MJPEG 
stream on the video source.  The Recorder will assume that the source is an MJPEG stream, and if 
this fails, it will attempt to use the URI as a JPEG with repeated HTTP requests at the interval 
specified by the Maximum FPS value. In the case of MJPEG, the Maximum FPS argument in the 
camera setup will be ignored, and video will be displayed at whatever rate the camera is capable 
of. Some cameras allow this to be set with arguments in the URI. 

A.3 Passive Camera 
The Passive camera type is for use in situations where the Vingtor-Stentofon Recorder cannot 
‘pull’ video from a camera, particularly when the camera is behind a NAT device, the connection is 
unreliable (cellular/radio), and it is desirable for the camera to ‘push’ video. 
 
In particular, this system comprises two portions: the Recorder portion, which is a configured 
Camera of the Passive type, and the Bridge application which can be used to turn an RTSP video 
source such as a camera or media server into a ‘pushing’ video source. 
 
The current incarnation of the Bridge is a command-line or GUI application the invocation of which 
takes the following form: 
 
BridgeApplication <rtspHost> <rtspPath> < RecorderHost>  < RecorderRtpPort> <username> <password> 
 
<rtspHost>   The host which will be serving RTSP to the Bridge. 
<rtspPath>   The path to the RTSP service on the RTSP Host. 
< RecorderHost> The host which runs the Recorder. 
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< RecorderRtpPort> The UDP port on which the Recorder will be listening for this bridge. 
<username>   The username used to authenticate this source to the Recorder. 
<password>   The password used to authenticate this source to the Recorder. 
 

 
The bridge will connect to the RTSP host and negotiate a media stream with that host over UDP.  
The bridge will then authenticate itself and describe this media stream to the RecorderHost via the 
configured RecorderRtpPort. The media will then be transmitted on this same port, with more 
control data being passed on the UDP port one greater than the RecorderRtpPort. Thus, if a 
passive camera is configured to send to UDP port 20122, the media and media description will be 
sent to 20122, and control data will be send to port 20123. The UTC time on the bridge host must 
be within 5 minutes of the time on the Recorder for authentication to function. 
 
When the bridge is shut down, it will send a TEARDOWN message to the RTSP host. If the RTSP 
host continues to send media after this message, it may be necessary to shut down and restart 
that RTSP host so as to ensure that the next time the bridge is run, it does not receive 2 copies of 
the media. 
 
Setting up a device for this passive source on the Recorder is similar to setting up other devices on 
the Recorder. 
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In contrast to other camera types, the URI/Address provided for this type defines the UDP port on 
which the Recorder will listen for data from this source. As described above, this port and the one 
immediately above it will be used for data and media transmission.  
 
Thus:  
 This port and the one above it may not be used for any other Passive source. 

 Wherever the bridge application is running, it must be able to send UDP to those two ports.  
This may require firewall, NAT traversal, port forwarding, and/or other network changes 
depending upon the network infrastructure present. 

 
MJPEG is not a valid media type for Passive video sources.  The Media Transport Type setting is 
disregarded for this Camera Type. In addition, because Passive Cameras become active when the 
Bridge runs, rather than when someone uses the Recorder, they must be configured to Force 
Stream Always so as to be always ready for a connection from the Bridge. 

A.4 Passive Audio 
Passive audio sources are those that send RTP audio to a given UDP port on the Recorder Server 
permanently. Vingtor-Stentofon IP stations can be set in this mode. 
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Name: A user-friendly identifier for this device. 

Device Type: PassiveAudio. 

Local UDP Port: This port number must match the port number as set in the Turbine station. Note 
that it is not allowed to have multiple stations streaming audio to the same port number. 

Media Type: Audio (this is pre-selected when the Device Type is set to PassiveAudio) 

 

A.5 AlphaCom 

A.5.1 AlphaCom XE Licenses 
Active recording is a license-based feature of the AlphaCom XE audio server. In AlphaPro it is 
possible to enable recording for as many specific intercom stations as the number of licenses 
purchased. To record both sides of a conversation, only 1 of the 2 stations in the conversation 
needs the appropriate flag set. 

This means that in an installation with many substations and only a few guard stations, where the 
substations are not able to call each other, only as many licenses are required as there are guard 
stations. 

When the recording interface is enabled (the license key has been inserted) it is also possible to 
record conferences and group calls. 
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To insert the license key for the AlphaCom, start AlphaWeb from a web browser by entering the IP 
address of the AlphaCom server and log in.  

• Default username: admin 

• Default password: alphaadmin 

To insert the license key: 

• Select System Configuration > Licensing 

• Click Insert new License Key 

• Enter the license key into the input field and click Insert Key 

• Accept the Terms and Conditions by clicking Yes  
The license key is now inserted but not yet activated.  

To activate the license key: 

• Click Yes to the question Do you want to reset the AMC system now? 

A.5.2 AlphaPro Programming – Recorder Interface 
Programming of the Recorder Interface is done via the tab Recording in the dialog-box where all 
system-wide information is programmed:  

• Start AlphaPro 

• Click the icon Exchange & System  

• In the dialog-box displayed, click the button System 

• In the dialog-box displayed, click the tab Recording 
Note that after sending the changes to the AlphaCom audio server, the audio server needs to be 
reset in order to activate the changes which are made as described in this section. 
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A.5.3 Recorder Registration 
The Recorder Software registers with the AlphaCom as a SIP device. If only one recorder is used, 
enter its registration name as Username for the Primary Recorder. If there is a redundant recorder 
as well, enter its registration name as Username for the Secondary Recorder. AlphaCom will first 
attempt to record a conversation on the Primary Recorder, but if that recorder is not available the 
Secondary Recorder will be used. Note that the fields IP address are not relevant for this 
application and should be left empty. 

The Recorder Software uses the default SIP Port: 5060 

A.5.4 Audio Streams 
The RTP audio stream characteristics should be set as follows: 

 Uncheck Force Mono Recording box 

 Check All box for Codecs 

The Recorder Software is able to capture multiple RTP streams for a conversation. It is therefore 
not necessary to force AlphaCom to mix those streams into a single stream. 

The Recorder Software supports all codecs that are also supported by AlphaCom. It is therefore 
not necessary to force a transcoding to a specific codec. 

A.5.5 Recording on Demand 
This section is added for future reference. At the time of writing, this feature is not yet available in 
the AlphaCom software. Before using this feature, please check whether AlphaCom supports it. 

By default all conversations of recording-enabled stations are recorded.  

When the Recording on demand box is checked, all conversations are only recorded after a 
specific data protocol command is sent to the AlphaCom. Note that this command can only be sent 
from the AlphaCom event handler. An example of commands are: 

 $REC L101 U1 - Start recording of conversation currently active on station L101 

 $REC L101 U0 - Stop ongoing recording active on station L101 

 $REC L8201 U1 - Start recording of conference 8201 

A.5.6 AlphaPro Programming – Stations 
In the dialog-box which opens after clicking the icon Users & Stations there are 2 checkboxes for 
each station: 

• Recording – Incoming 

• Recording – Outgoing 
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Checking these boxes will determine whether only incoming or outgoing calls should be recorded, 
or both. Note that only as many stations should be selected for recording as recording licenses 
have been purchased to avoid calls not being recorded. 

By default the Recording boxes are unchecked. In a system where most stations need recording it 
is possible to click the button Apply to All. The recording flag for all 552 users will be set just the 
same as for the user where the Apply to All button is selected. 

Conversations within the same AlphaCom will only be recorded once, even if for both stations in 
the conversation, both Recording boxes are checked. 

If one of the stations has the appropriate Recording box checked, the conversation will be recorded 
independent of whether any Recording boxes are checked for the other participant in the 
conversation. 

A.5.7 AlphaPro Programming – Group Calls 
When a recording license is present, all local and global group calls are recorded by default, 
independent of whether stations have a Recording box checked or not. Recording of specific local 
and global group calls can be disabled by unchecking the Recording box for the group call. 

In AlphaPro, click the icon Groups and select the local or global group. Check or uncheck the 
Recording box as required. 
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A.5.8 AlphaPro Programming – Conferences 
When a recording license is present, all simplex and duplex conferences are recorded by default, 
independent of whether stations have a Recording box checked or not. Recording of specific 
conferences can be disabled by unchecking the Recording box for the conference. 

In AlphaPro, click the icons Simplex Conferences or Open Duplex Conferences and select the 
appropriate conference. Check or uncheck the Recording box as required. 

Simplex Conference: 

 

Duplex Conference: 

 

A.5.9 AlphaNet 
Similar to stations, each AlphaNet link also has 2 recording flags associated with it, for incoming 
and outgoing calls. By default both these flags are set. 

For recording of AlphaNet calls the rule is:  

• Record incoming call if both the Incoming box for the station AND the Incoming box for 
the source node are checked 

• Record incoming call if both the Outgoing box for the station AND the Outgoing box for 
the destination node are checked 

This makes it possible to select the side on which to record an AlphaNet call or to have the option 
to record the call at both ends.  

The AlphaNet recording checkboxes are part of the AlphaNet Routing dialog-box: 
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The Recording Software is able to register with many AlphaCom XE audio servers simultaneously, 
depending on the AlphaCom connection licenses that are available for the recorder, so even in a 
large AlphaNet it is possible to only use a single recorder. However in geographically dispersed 
systems it may be advisable to have recorders at different locations. 

Note that every AlphaCom XE audio server in an AlphaNet requires its own recording licenses. 

If a single recorder is used, make certain that conversations are only recorded from one AlphaCom 
– do not check both Incoming and Outgoing boxes on all AlphaCom servers in the network 

A.6 Turbine Stations & Permanent Audio Streaming 
To stream audio as a Passive Audio device, a Turbine station needs to be put in Permanent 
Audio Stream mode. This mode is a licensed feature - the item number for this license is: 

 1009296998 – IP Station Audio Surveillance 

Once the license key has been entered in the station web interface, a new page becomes available 
under Advanced Network > Audio Surveillance. 

 

 Check the Enable Audio Stream box 

 Enter the IP address of the recorder server in the Remote Domain field 
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 Enter the port number to which this Turbine station will be streaming in the Remote Port 
field.  
Note that each station must stream to a unique port number. 

 Set the Codec to g722 

 Click Save Stream configuration 

 

 

A.7 Problem solving 
Choppy Audio on playback: see paragraph 3.2.1, the description for RTP Playback Timer. 

License file is not accepted: Unfortunately, some e-mail software causes a corruption of the license 
file during encoding. If the file is corrupted the recorder configuration application will respond with 
the message that either the license is not valid, or has expired. If this happens, please ask your 
distributor to contact Zenitel and ask whether the license file can be sent to you directly from 
Zenitel. 
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